To order toner cartridges and supplies from Dell:

1. Double-click the icon on your desktop.

2. Visit Dell's website, or order Dell printer supplies by phone.

   www.dell.com/supplies

   For the best service, ensure that you have the Dell printer Service Tag available. For more information about your service tag, see Express Service Code and Service Tag number.

---

**Finding Information**
- Software Overview
- Printing
- Maintaining Your Printer
- Troubleshooting
- Specifications
- Appendix
- Licensing Notice

---

**Notes, Notices, and Cautions**

NOTE: A NOTE indicates important information that helps you make better use of your printer.

NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.

© 2006 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell, the DELL logo, OpenManage, and Dell Toner Management System are trademarks of Dell Inc.; Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. Windows Server and Windows NT are registered trademarks of Microsoft Corporation. Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.

Sun, Sun Microsystems, Solaris, and the Solaris logo are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries, and are under license.

SUSE is a registered trademark of Novell, Inc. in the United States and other countries.

Red Hat is a registered trademark of Red Hat, Inc. in the United States and other countries.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.
# Finding Information

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Drivers for my printer</td>
<td>Drivers and Utilities CD</td>
</tr>
<tr>
<td>• My User's Guide</td>
<td></td>
</tr>
</tbody>
</table>

If you purchased your Dell computer and printer at the same time, documentation and drivers for your printer are already installed on your computer. You can use the *Drivers and Utilities CD* to uninstall/reinstall drivers or access your documentation. Readme files may be included on your CD to provide last-minute updates about technical changes to your printer or advanced technical reference material for experienced users or technicians.

<table>
<thead>
<tr>
<th>How to set up my printer</th>
<th>Setting Up Your Printer poster</th>
</tr>
</thead>
</table>

| • Safety information     | Owner's Manual                |
| • How to set up and use my printer |             |
| • Warranty information  |                               |

<table>
<thead>
<tr>
<th>Express Service Code and Service Tag number</th>
<th>Express Service Code and Service Tag number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The illustration below shows the location of the label on the printer.</td>
</tr>
<tr>
<td>• Latest drivers for my printer</td>
<td></td>
</tr>
<tr>
<td>• Answers to technical service and support questions</td>
<td></td>
</tr>
<tr>
<td>• Documentation for my printer</td>
<td>Dell Support website: <a href="http://support.dell.com">support.dell.com</a></td>
</tr>
</tbody>
</table>

The Dell Support website provides several online tools, including:

- Solutions—Troubleshooting hints and tips, articles from technicians, and online courses.
- Upgrades—Upgrade information for components, such as memory
- Customer Care—Contact information, order status, warranty, and repair information
- Downloads—Drivers
- Reference—Printer documentation and product specifications

| • How to use Windows® XP Documentation for my printer | Windows XP Help and Support Center |
| 1. Click **Start**® **Help and Support**. |  |
| 2. Type a word or phrase that best describes your problem, and then click the arrow icon. |  |
| 3. Click the topic that describes your problem. |  |
| 4. Follow the instructions shown on the screen. |  |

| • How to use Windows Vista™ Documentation for my printer |  |
| 1. Click ® **Help and Support**. |  |
| 2. Type a word or phrase that best describes your problem, and then click the magnifying glass icon. |  |
| 3. Click the topic that describes your problem. |  |
| 4. Follow the instructions shown on the screen. |  |
Software Overview

- Dell Toner Management System™
- Status Monitor Center
- Dell Local Printer Settings Utility
- Set IP Address Utility
- Dell Printer Software Uninstall Utility
- Driver Profiler
- Dell Printer Configuration Web Tool
- Dell Printer Alert Utility

Use the Drivers and Utilities CD that came with your printer to install a combination of software applications, depending on your operating system.

**NOTE:** If you purchased your printer and computer separately, you must use the Drivers and Utilities CD to install these software applications.

**NOTE:** These software applications are not available with Linux or Macintosh.

Dell Toner Management System™

Printing Status Window

**NOTE:** This application is not available if you are using Windows® NT.

**NOTE:** For the Printing Status Window to work properly, bidirectional communication support must be in place so the printer and computer can communicate. An exception is added to the Windows® Firewall to allow this communication.

Use the Status Monitor Center to manage multiple Status Monitors.

The Printing Status window displays the status of the printer (Printer Ready, Printer Offline, and Error-Check Printer) and the name of the job when you send a job to print.

The Printing Status window also displays the level of toner so you can:

- Monitor the toner level for your printer.
- Click Order Toner to order replacement toner cartridges.

Dell Printer Supplies Reorder Application

The Order Supplies dialog box can be launched from the Printing Status window, the Programs window, or the desktop icon.

You can order toner by phone or from the Web.

- If ordering from the Dell Printer Supplies Reorder Application:
  1. Click **Start® Programs** or **All Programs® Dell Printers® Dell Laser Printer 1720**.

    *For Windows Vista (default Start menu):*
a. Click ® Programs.

b. Click Dell Printers.

c. Click Dell Laser Printer 1720.

2. Click Printer Supplies Reorder Application.

The Ordering Supplies dialog box opens.

- If ordering from the Web, click Visit Dell's cartridge ordering web site.
- If ordering by phone, call the number that appears under the By Telephone heading.

---

**Status Monitor Center**

⚠ **NOTE:** For the local Status Monitor Center to work properly, bidirectional communication support must be in place so the printer and computer can communicate. An exception is added to the Windows® Firewall to allow this communication.

Use the Status Monitor Center to manage multiple Status Monitors.

- Double-click a printer name to open its Status Monitor, or select Run to open a Status Monitor for a particular printer.
- Select Update to change the appearance of the list of printers.
- Select Help to read the online Help.

---

**Dell Local Printer Settings Utility**

⚠ **NOTE:** This application is not available when the printer is connected to a network.

Use the Dell Local Printer Settings Utility to change and save printer settings not available from the printer software (for example, activating Alarm Control if you want the printer to sound an alarm when it needs attention).

The Dell Local Printer Setup Utility is installed automatically on your computer when you install the Dell printer software. To access the utility:

1. Click Start® Programs or All Programs® Dell Printers® Dell Laser Printer 1720.

   * For Windows Vista (default Start menu):
   
   a. Click ® Programs.
   
   b. Click Dell Printers.
   
   c. Click Dell Laser Printer 1720.

   2. Click Dell Local Printer Settings Utility.

   ⚠ **NOTE:** The Dell Local Printer Settings Utility only functions with printers connected directly to the computer.

You can change the following settings using the Dell Local Printer Settings Utility:

<table>
<thead>
<tr>
<th>PAPER MENU</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Source</td>
<td></td>
</tr>
<tr>
<td>Paper Size 1</td>
<td></td>
</tr>
</tbody>
</table>
- Paper Type<sup>1</sup>
- Custom Types<sup>2</sup>
- Substitute Size
- Paper Texture<sup>3</sup>
- Paper Weight<sup>3</sup>

### FINISHING MENU
- Duplex
- Duplex Bind
- Copies
- Blank Pages
- Collation
- Separator Sheets
- Separator Source
- Multipage Print
- Multipage Order
- Multipage View
- Multipage Border

### QUALITY MENU
- Print Resolution
- Toner Darkness
- Small Font Enh

### SETUP MENU
- Eco-Mode
- Quiet Mode
- Printer Language
- Power Saver
- Resource Save
- Download Target
- Print Timeout
- Wait Timeout
- Auto Continue
- Jam Recovery
- Page Protect
- Print Area
- Display Language
- Toner Alarm

### PCL EMUL MENU
- Orientation
- Lines Per Page
- A4 Width
- Tray Renumber<sup>1</sup>
- Auto CR after LF
- Auto LF after CR

### POSTSCRIPT MENU
- Print PS Error
- Font Priority

### PARALLEL MENU
- PCL SmartSwitch
- PS SmartSwitch
- Parallel Buffer
- Advanced Status
- Honor Init

### USB MENU
- PCL SmartSwitch
- PS SmartSwitch
- USB Buffer

<sup>1</sup> Per supported source
Set IP Address Utility

NOTE: This application is not available when the printer is locally attached to a computer.

NOTE: For the Set IP Address Utility to work properly, an exception is added to the Windows® Firewall.

Use the Status Monitor Center to manage multiple Status Monitors.

The Set IP Address Utility lets you set up an IP address and other important IP parameters. To set the IP address manually:

1. Launch the Dell Printer Configuration Web Tool by typing your network printer’s IP address in your web browser.
2. Click Printer Settings.
3. Under Printer Server Settings, click TCP/IP.
4. Enter the IP Address and the Netmask and Gateway settings.
   
   NOTE: If you do not know these settings, contact your network administrator.
5. Click Submit.
6. Enter the new IP address in your browser to continue using the Dell Printer Configuration Web Tool.

Dell Printer Software Uninstall Utility

Use the Uninstall Software Utility to remove any currently installed printer software or printer objects.

1. Click Start® Programs or All Programs® Dell Printers.

   For Windows Vista (default Start menu):
   a. Click ® Programs.
   b. Click Dell Printers.
2. Click Dell Printer Software Uninstall.
3. Select the components you want to uninstall, and then click Next.
4. Click Finish.
5. When the uninstall is completed, click OK.

Driver Profiler

Use the Driver Profiler to create driver profiles that contain custom driver settings. A driver profile can contain a group of saved printer driver settings and other data for such things as:

- Print orientation and N-Up (document settings)
Installation status of an output tray (printer options)

User-defined paper sizes (custom papers)

Simple text and watermarks

Overlay references

Font references

Form associations

---

**Dell Printer Configuration Web Tool**

*NOTE:* This application is not available when the printer is connected locally to a computer.

Have you ever sent a print job to the network printer down the hall, only to find it didn't print because of a paper jam or an empty paper tray? One of the features of the Dell Printer Configuration Web Tool is the E-mail Alert Setup, which sends you, or the key operator, an e-mail when the printer needs supplies or intervention.

If you fill out printer inventory reports requiring the asset tag number of all of the printers in your area, the Dell Printer Configuration Web Tool has a Printer Information feature that makes it easy. Type the IP address of each printer on the network to display the asset tag number.

The Dell Printer Configuration Web Tool feature also lets you change printer settings and keep track of printing trends. If you are a network administrator, you can easily copy the printer's settings to one or all printers on the network—right from your Web browser.

To launch the Dell Printer Configuration Web Tool, type your network printer's IP address in your Web browser.

If you do not know what your printer's IP address is, print a network setup page, which lists the IP address.

To print a network setup page, press and release the **Continue** button.

Use the Dell Printer Configuration Web Tool for:

- **Printer Status**—Get immediate feedback on printer supply status. When toner is running low, click the toner supplies link on the first screen to order additional toner cartridges.

- **Printer Settings**—Change printer settings, view the operator panel remotely, and update the print server firmware.

- **Copy Printer Settings**— Quickly clone the printer's settings to another printer or printers on the network by typing each printer's IP address.

*NOTE:* You must be a network administrator to use this feature.
- **Printing Statistics**—Keep track of printing trends, such as paper usage and types of jobs being printed.

- **Printer Information**—Get the information you need for service calls, inventory reports, or the status of current memory and engine code levels.

- **E-mail Alert Setup**—Receive an e-mail when the printer needs supplies or intervention. Type your name or the key operator’s name in the e-mail list box to be notified.

- **Set Password**—Lock the operator panel with a password so that other users don't inadvertently change the printer settings you selected.

  **NOTE:** You must be a network administrator to use this feature.

- **Online Help**—Click Help to visit the Dell website for printer troubleshooting.

---

### Dell Printer Alert Utility

**NOTE:** This application is not available with Windows NT or Windows 2000.

The Dell Printer Alert Utility informs you when there are errors requiring your intervention on your printer. When there is an error, a bubble appears telling you what the error is, and points you to the appropriate recovery information.

**NOTE:** For the Dell Printer Alert Utility to work properly, bidirectional communication support must be in place so the printer and computer can communicate. An exception is added to the Windows Firewall to allow this communication.

If you opted to install the Dell Printer Alert Utility with your printer software, the utility automatically launches when the software installation is completed. The utility is active if you see ☰ in the System Tray.

To disable the Dell Printer Alert Utility:

1. From the System Tray, right click the ☰ icon.
2. Select Exit.

To re-enable the Dell Printer Alert Utility:

1. Click Start® Programs or All Programs® Dell Printers® Dell Laser Printer 1720.

   *For Windows Vista (default Start menu):*
   
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell Laser Printer 1720.

2. Click Printer Alert Utility.
# About Your Printer

- Understanding Your Printer
- Understanding the Operator Panel
- Printing the Printer Settings Configuration Sheet
- Choosing the Right Cable

## Understanding Your Printer

<table>
<thead>
<tr>
<th>1</th>
<th>Front exit</th>
<th>Part from which the paper exits the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Output bin extender</td>
<td>Support for the paper as it exits the printer.</td>
</tr>
<tr>
<td>3</td>
<td>Front cover</td>
<td>Door you open to gain access to the toner cartridge and photoconductor.</td>
</tr>
<tr>
<td>4</td>
<td>Manual feeder</td>
<td>Part for which you manually load various paper types such as envelopes.</td>
</tr>
<tr>
<td>5</td>
<td>Manual feeder paper guides</td>
<td>Guides you adjust to the size of the paper you are manually loading to prevent paper jams.</td>
</tr>
<tr>
<td>6</td>
<td>Optional 550-sheet drawer (Tray 2)</td>
<td>Tray that you can purchase separately to increase the amount of blank paper that your printer can hold.</td>
</tr>
<tr>
<td>7</td>
<td>Tray 1</td>
<td>Standard paper tray that can hold 250 sheets of paper.</td>
</tr>
<tr>
<td>8</td>
<td>Operator panel</td>
<td>Panel on the printer you use to control print jobs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>9</th>
<th>USB port</th>
<th>Slot into which you plug the USB cable (sold separately). The other end of the USB cable plugs into your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Parallel port</td>
<td>Slot into which you plug the parallel cable (sold separately). The other end of the parallel cable plugs into your computer.</td>
</tr>
</tbody>
</table>
Understanding the Operator Panel

The operator panel has six lights and two buttons.

- Press the Continue button to resume printing.
- Press the Continue button twice quickly to display an error code.
- Press the Cancel button to cancel the job currently printing.
- Press and hold the Cancel button until all of the lights come on to reset the printer.

Printing the Printer Settings Configuration Sheet

To help resolve printing problems or to change printer configuration settings, advanced users can print the Printer Settings Configuration sheet for instructions on advancing through the configuration menus to select and save new settings.

1. Turn off the printer.
2. Open the front cover.
3. Press and hold the Continue button as you turn on the printer.

All the lights cycle.
4. Release the **Continue** button.

5. Close the front cover.

   The light sequence representing the Home menu is displayed.

6. Press the **Continue** button until all the lights cycle.

   The Printer Settings Configuration sheet prints.

   **NOTE:** The sheet prints only when the Home menu is displayed.

---

### Choosing the Right Cable

Your printer interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Cable certification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Parallel</td>
<td>IEEE-1284</td>
</tr>
<tr>
<td>10/100BaseT Ethernet</td>
<td>CAT-5E</td>
</tr>
</tbody>
</table>
Manually Feeding a Print Job

The manual feeder is located at the front of your printer and can only feed one sheet of print media at a time.

When using the manual feeder, send the print job to the printer before loading the print media. When the printer is ready, it displays the Load Manual Feeder light sequence, at which point you should load the media.

1. With your document open, click File > Print.
2. Click Properties (or Options, Printer, or Setup, depending on the application or operating system).
   The Printing Preferences dialog box opens.
3. Click the Paper tab.
5. Make any necessary changes for your document.
6. Click OK.
7. Click **OK** on the Print window to send the job to print.

The printer displays the **Load Manual Feeder** light sequence.

8. Place a sheet of the selected print media, print side facing up, at the center of the manual feeder, but only to the point where its leading edge can contact the paper guides.

   - Insert envelopes with the flap side facing down and with the stamp area as shown.
   - Hold transparencies by the edges and avoid touching the print side. Oil from your fingers that is deposited on the transparency can affect print quality.
   - Load letterhead facing up, with the top of the sheet entering the printer first.
   - If you experience problems with paper feed, turn the paper around.

9. Adjust the paper guides to the print media's width.

10. Hold both sides of the print media close to the manual feeder, and push it into the printer until it automatically engages.

There is a brief pause between the time the printer engages the print media and when it feeds into the printer.

**NOTICE:** Do not force the print media into the feeder. Forcing the media causes jams.

---

**Printing on Both Sides of the Paper**

Printing on both sides of the paper reduces printing costs.

You can choose how you want your job duplexed: long edge or short edge.

- Long edge means pages are bound along the long edge of the page (left edge for portrait, top edge for landscape).

  ![Long Edge Diagram]

- Short edge means pages are bound along the short edge of the page (top edge for portrait, left edge for landscape).

  ![Short Edge Diagram]
Dell Laser Printer 1720 — Manual Duplex

1. With your document open, click File ➤ Print.

2. Click Properties (or Options, Printer, or Setup, depending on the application or operating system).

   The Printing Preferences dialog box opens.

3. Select either 2-sided long edge or 2-sided short edge.

4. Click the Paper tab.

5. Select the appropriate Input Options for your print job.

6. Click OK.

7. Click OK on the Print window to send the job to print.

   The printer prints every other page of the document first. Once the first side of your job prints, the Duplex light sequence is displayed.

8. Load the paper back into Tray 1 with the already-printed side facing up and the top of the page toward the front of the tray.

[Image]

NOTE: Although you can use Tray 1 or Tray 2 to print the first side of the duplex job, only use Tray 1 to print the second side.

Dell Laser Printer 1720dn — Automatic Duplex

[NOTE] The automatic duplex function is only available on the Dell Laser Printer 1720dn.

1. With your document open, click File ➤ Print.

2. Click Properties (or Options, Printer, or Setup, depending on the application or operating system).

   The Printing Preferences dialog box opens.

3. Click the Page Layout tab.

4. Under 2-sided printing, select 2-sided long edge or 2-sided short edge (depending on your printing needs).

5. Click OK.

6. Click OK.

Printing Multiple Page Images on One Page (N-Up Printing)
The Multipage Printing (N-up) setting is used to print multiple page images on a single page. For example, 2-up means two page images are printed on one page.

The printer uses the Multipage Order, Multipage View, and Multipage Border settings to determine the order and orientation of the page images, and whether a border is printed around each page image.

1. With your document open, click **File** ➔ **Print**.

2. Click **Properties** (or **Options**, **Printer**, or **Setup**, depending on the application or operating system).

   The **Printing Preferences** dialog box opens.

3. In the **Multipage printing (N-up)** section, specify the number of pages you want printed on a sheet by typing a number or using the arrows in the combo box.

4. Click **OK**.

5. Click **OK** on the Print window to send the job to print.

---

**Printing a Booklet**

The **Booklet** setting lets you print multiple pages in booklet form without having to re-format your document so the pages print in the proper order. The pages print so the finished collated document may be folded along the center of each page to form a booklet.

If the document contains many pages, a booklet may have too many pages to fold easily. If you are printing a fairly large booklet, you might want to use the **Sheets per Bundle** option to specify how many physical pages are put into one bundle. The printer prints the necessary number of bundles, which you can then bind into one booklet. Printing in bundles helps the outside edge of the pages line up more evenly.

You must specify whether or not you want to print using any duplex printing options before you select to print using the booklet function. Once you choose **Print Using Booklet**, the controls for the duplex options become inactive and remain at the last setting used.

1. With your document open, click **File** ➔ **Print**.

2. Click **Properties** (or **Options**, **Printer**, or **Setup**, depending on the application or operating system).

   The **Printing Preferences** dialog box opens.

3. Click **More Page Layout Options**.

4. Click **Booklet**.

5. Click **OK** twice.

6. Click **OK** on the Print window to send the job to print.

---

**Printing a Poster**
The Poster setting lets you print a single image across several pages. Once printed, you can combine the pages to create one large image.

1. With your document open, click File > Print.
2. Click Properties (or Options, Printer, or Setup, depending on the application or operating system).
   The Printing Preferences dialog box opens.
3. Click More Page Layout Options.
4. Click Poster.
5. Select the poster size you want by choosing the number of pages to use in the poster.
6. To print crop marks on the page, select Print crop marks.
7. Select the amount of overlap you want each page to have.
8. Click OK twice.
9. Click OK on the Print window to send the job to print.

**Printing on Letterhead**

1. Ensure that the letterhead is properly loaded according to the paper source you are using:
   - Tray 1 or 2—Load the letterhead with the print side facing down. The top edge of the sheet with the logo should be placed at the front of the tray.
   - Manual feeder—Load the letterhead with the print side facing up and the top of the sheet entering the printer first.

**NOTE:** If you are using the manual feeder, first send the job to print, then load the letterhead when the printer displays the Load Manual Feeder light sequence.

2. With your document open, click File > Print.
3. Click **Properties** (or **Options**, **Printer**, or **Setup**, depending on the application or operating system).

   The **Printing Preferences** dialog box opens.

4. Click the **Paper** tab.

5. Select **Letterhead** from the **Paper Type** drop-down list.

6. Select the appropriate paper size and tray.

7. Click **OK**.

8. Click **OK** on the Print window to send the job to print.

---

### Canceling a Print Job

A print job can be canceled from the operator panel or from your computer. The **Cancel Job** light sequence is displayed on the operator panel while the job is being canceled.

#### From the Printer Operator Panel

Press and release the **Cancel** button to cancel the current print job.

#### From Your Computer

1. *For Windows® XP (default Start menu):*
   
   a. Click **Start**  **Control Panel**.
   
   b. Double-click **Printers and Other Hardware**.
   
   c. Double-click **Printers and Faxes**.

   *For Windows XP (Classic Start menu):* Click **Start**  **Settings**  **Printers and Faxes**.

   *For Windows Vista™ (Classic Start menu) and all other Windows versions:* Click **Start**  **Settings**  **Printers**.
For Windows Vista (default Start menu):

   a. Click ® Control Panel.

   b. Click Hardware and Sound.

   c. Click Printers.

2. Double-click the printer you are using to print the job.

   A list of print jobs appears.

3. Right-click the document you want to stop printing, and then click Cancel.
Operator Panel Menus

- **Network Menu**
- **Parallel Menu**
- **Setup Menu**
- **USB Menu**
- **Utilities Menu**

Menus are represented by Ready, Toner Low/Replace Drum, Load Paper/Remove Output, and Paper Jam light sequences. Menu items and their settings are indicated by Error and Continue light sequences.

- Press the **Cancel** button to advance through the menus and menu items.
- Press the **Continue** button to advance to the setting you need.
- Press and hold the **Continue** button until all the lights cycle to save a setting.
- Press and hold the **Cancel** button until all the lights cycle to return to the Home menu.
- Turn off the printer to exit the menus.

## Network Menu

Use the Network menu to change printer settings on jobs sent through a network port (either Standard Network or Network Opt <x>).

<table>
<thead>
<tr>
<th>From this menu:</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPA Mode</td>
<td>Send print jobs to the printer and query printer status information simultaneously.</td>
</tr>
<tr>
<td></td>
<td>• Off</td>
</tr>
<tr>
<td></td>
<td>• On*</td>
</tr>
<tr>
<td>MAC Binary PS</td>
<td>Configure the printer to process Macintosh binary PostScript print jobs.</td>
</tr>
<tr>
<td></td>
<td>• Off—the printer filters PostScript print jobs using standard protocol.</td>
</tr>
<tr>
<td></td>
<td>• On—the printer processes raw binary PostScript print jobs from computers using the Macintosh operating system.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This setting can cause print jobs sent from Windows to fail.</td>
</tr>
<tr>
<td></td>
<td>• Auto*—the printer processes print jobs from computers using either Windows or Macintosh operating systems.</td>
</tr>
<tr>
<td>Set Card Speed</td>
<td>Automatically detect the connection speed of your network. You can disable this setting to set the speed manually.</td>
</tr>
<tr>
<td></td>
<td>• Auto*—the printer attempts to connect to the network at the current network speed.</td>
</tr>
<tr>
<td></td>
<td>• 10 Mbps, Half Duplex—the printer attempts to connect to the network at 10 Mbps, Half Duplex.</td>
</tr>
<tr>
<td></td>
<td>• 10 Mbps, Full Duplex—the printer attempts to connect to the network at 10 Mbps, Full Duplex.</td>
</tr>
<tr>
<td></td>
<td>• 100 Mbps, Half Duplex—the printer attempts to connect to the network at 100 Mbps, Half Duplex.</td>
</tr>
<tr>
<td></td>
<td>• 100 Mbps, Full Duplex—the printer attempts to connect to the network at 100 Mbps, Full Duplex.</td>
</tr>
</tbody>
</table>

* Factory default setting
**Parallel Menu**

Use the Parallel menu to change printer settings on jobs sent through a parallel port.

<table>
<thead>
<tr>
<th>From this menu:</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPA Mode</td>
<td>Send print jobs to the printer and query printer status information at the same time.</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Auto*</td>
</tr>
<tr>
<td>Protocol</td>
<td>Receive information at a much higher transmission rate if your printer is set to Fastbytes (if your computer supports Fastbytes), or receive information at a normal transmission rate if your printer is set to Standard.</td>
</tr>
<tr>
<td></td>
<td>- Standard</td>
</tr>
<tr>
<td></td>
<td>- Fastbytes*</td>
</tr>
<tr>
<td>Parallel Mode 2</td>
<td>Determine whether the parallel port data is sampled on the leading (on) or trailing (off) edge of the strobe.</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td>- On*</td>
</tr>
<tr>
<td>MAC Binary PS</td>
<td>Configure the printer to process Macintosh binary PostScript print jobs.</td>
</tr>
<tr>
<td></td>
<td>- Off—the printer filters PostScript print jobs using standard protocol.</td>
</tr>
<tr>
<td></td>
<td>- On—the printer processes raw binary PostScript print jobs from computers using the Macintosh operating system.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This setting can cause print jobs sent from Windows to fail.</td>
</tr>
<tr>
<td></td>
<td>- Auto*—the printer processes print jobs from computers using either Windows or Macintosh operating systems.</td>
</tr>
</tbody>
</table>

* Factory default setting

**Setup Menu**

Use the Setup menu to configure how the printer formats the end of a line depending on the computer system being used.

<table>
<thead>
<tr>
<th>From this menu:</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPDS Emulation</td>
<td>Specify if you want to use the PPDS datastream.</td>
</tr>
<tr>
<td></td>
<td>- Deactivate*</td>
</tr>
<tr>
<td></td>
<td>- Activate</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This menu is only displayed if a PPDS interpreter is available.</td>
</tr>
<tr>
<td>Auto CR after LF</td>
<td>Specify whether the printer automatically performs a carriage return (CR) after a line feed control command.</td>
</tr>
<tr>
<td></td>
<td>- Off*</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
<tr>
<td>Auto LF after CR</td>
<td>Specify whether the printer automatically performs a line feed (LF) after a carriage return control command.</td>
</tr>
<tr>
<td></td>
<td>- Off*</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
</tbody>
</table>
### USB Menu

Use the USB menu to change printer settings on jobs sent through a USB port.

<table>
<thead>
<tr>
<th>From this menu:</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NPA Mode</td>
<td>Send print jobs to the printer and query printer status information at the same time.</td>
</tr>
<tr>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td>- Auto*</td>
</tr>
<tr>
<td>MAC Binary PS</td>
<td>Configure the printer to process Macintosh binary PostScript print jobs.</td>
</tr>
<tr>
<td></td>
<td>- Off—the printer filters PostScript print jobs using standard protocol.</td>
</tr>
<tr>
<td></td>
<td>- On—the printer processes raw binary PostScript print jobs from computers using the Macintosh operating system.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This setting can cause print jobs sent from Windows to fail.</td>
</tr>
<tr>
<td></td>
<td>- Auto*—the printer processes print jobs from computers using either Windows or Macintosh operating systems.</td>
</tr>
<tr>
<td>USB Speed</td>
<td>Specify the speed of the USB cable you are using.</td>
</tr>
<tr>
<td></td>
<td>- Full</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This forces the USB port to run at full speed, disabling all high-speed capabilities.</td>
</tr>
<tr>
<td></td>
<td>- Auto*</td>
</tr>
</tbody>
</table>

* Factory default setting

### Utilities Menu

Use the Utilities menu to troubleshoot printer problems.

<table>
<thead>
<tr>
<th>From this menu:</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Configuration Mode Instructions</td>
<td>Press and hold the <strong>Continue</strong> button.</td>
</tr>
<tr>
<td>Reset Factory Defaults</td>
<td>Return your printer settings to the factory default values by pressing and holding the <strong>Continue</strong> button.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> All downloaded resources (fonts, macros, and symbol sets) in printer memory (RAM) are deleted. Resources in flash memory are unaffected.</td>
</tr>
<tr>
<td>Hex Trace</td>
<td>Help isolate printing problems when unexpected characters print or characters are missing. Hex Trace helps you determine if there is a problem with the language interpreter or the cable by telling you what information your printer is receiving.</td>
</tr>
</tbody>
</table>
To exit Hex Trace, turn off the printer.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Quality Test Pages</td>
<td>Help isolate print quality problems, such as streaking. Three pages print to help you evaluate print quality: a text page with printer information, cartridge information, current margin settings and a graphic; and two pages with graphics. Press and hold the <strong>Continue</strong> button.</td>
</tr>
<tr>
<td>Reset Photoconductor Counter</td>
<td>Return the photoconductor counter to zero. <strong>NOTE:</strong> The replace photoconductor message should be cleared only when the imaging drum has been replaced.</td>
</tr>
<tr>
<td>Reduced Curl</td>
<td>Reduce the throughput in order to reduce page curl.</td>
</tr>
<tr>
<td></td>
<td>- Off*</td>
</tr>
<tr>
<td></td>
<td>- On</td>
</tr>
</tbody>
</table>

* Factory default setting
Maintaining Your Printer

- Ordering Supplies
- Storing Supplies
- Replacing the Toner Cartridge
- Replacing the Imaging Drum
- Cleaning the Printhead Lens

Ordering Supplies

Printer Attached to a Network

1. Type your printer IP address in your Web browser to launch the Dell Configuration Web Tool.
2. Click www.dell.com/supplies.

Printer Attached Locally to a Computer

1. Click Start® Programs or All Programs® Dell Printers® Dell Laser Printer 1720.

   For Windows Vista™ (default Start menu):
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell Laser Printer 1720.
2. Click Dell Printer Supplies Reorder Application.
   The Order Toner Cartridges window opens.
3. Choose your printer model from the drop-down list.
4. Enter your Dell printer Service Tag number.

   NOTE: Your Service Tag number is located inside the front cover of your printer.
5. Click Visit Dell's cartridge ordering website.

Storing Supplies

Storing Print Media

Use the following guidelines for proper print media storage. These help avoid paper feeding problems and uneven print quality.
• For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so the edges do not buckle or curl.

• Do not place anything on top of the print media packages.

### Storing the Toner Cartridge

Store the toner cartridge in the original packaging until you are ready to install it.

Do not store the toner in:

• Temperatures greater than 40°C (104°F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• An environment with salty air.

### Replacing the Toner Cartridge

You can determine approximately how much toner is left in your cartridge by printing the printer settings configuration sheet. This helps you decide when you might need to order replacement supplies.

The **Toner low** light sequence is displayed when the toner cartridge is nearly empty. You can still print for a short time while this sequence is displayed, but print quality decreases as the toner level decreases.
When the **Toner low** light sequence appears, or when you experience faded print, remove the toner cartridge. Firmly shake it side-to-side and front-to-back several times to redistribute the toner, and then reinsert it and continue printing. Repeat this procedure multiple times until print remains faded. When the print remains faded, replace the toner cartridge.

1. Open the front cover by pressing the button on the left side of the printer and lowering the cover.

![Open Front Cover](image1)

2. Press the button on the base of the toner cartridge assembly.

![Press Button](image2)

3. Pull the toner cartridge up and out using the handle.

![Pull Toner Cartridge](image3)

4. Unpack the new toner cartridge.

5. **NOTICE:** When replacing a toner cartridge, do not leave the new cartridge exposed to direct light for an extended period of time. Extended light exposure can cause print quality problems.

6. Rotate the cartridge in all directions to distribute the toner.

![Rotate Toner Cartridge](image4)

6. Install the new toner cartridge by aligning the white rollers on the toner cartridge with the arrows on the tracks of the imaging drum and pushing the toner cartridge in as far as it will go. The cartridge **clicks** into place when correctly installed.
7. Close the front cover.

---

**Replacing the Imaging Drum**

You can determine approximately how full the imaging drum is by printing the printer settings configuration sheet. This helps you decide when you might need to order replacement supplies.

To ensure print quality and to avoid damage to the printer, the printer stops operating after the imaging drum has reached a maximum of 40,000 pages. The printer automatically notifies you before the imaging drum reaches this point.

When you first receive the **Replace imaging drum** light sequence, you should immediately order a new imaging drum. While the printer may continue to function properly after the imaging drum has reached its official end-of-life (approximately 30,000 pages), print quality significantly decreases until the imaging drum stops operating at the maximum of 40,000 pages.

![Image of printer lights]

**NOTICE:** When replacing a toner cartridge, do not leave the new cartridge exposed to direct light for an extended period of time. Extended light exposure can cause print quality problems.

1. Open the front cover by pressing the button on the left side of the printer and lowering the cover.
2. Pull the toner cartridge assembly out of the printer by pulling on the toner cartridge handle.

   NOTE: Do not press the button on the toner cartridge assembly.

   Place the toner cartridge assembly on a flat, clean surface.

3. Press the button on the base of the toner cartridge assembly.

4. Pull the toner cartridge up and out using the handle.

5. Unpack the new imaging drum.

6. Install the toner cartridge into the new toner cartridge assembly by aligning the white rollers on the toner cartridge with the white arrows on the tracks of the imaging drum and pushing the toner cartridge in as far as it will go. The cartridge clicks into place when correctly installed.
7. Install the toner cartridge assembly into the printer by aligning the blue arrows on the guides of the toner cartridge with the blue arrows in the printer and pushing the toner cartridge assembly as far as it will go.

8. After you replace the imaging drum, you should reset the imaging drum's counter. To reset the counter, press and hold the **Cancel** button until all lights flash in sequence.

**NOTICE:** Resetting the imaging drum's counter without replacing the imaging drum may damage your printer and void your warranty.

9. Close the front cover.

---

**Cleaning the Printhead Lens**

1. Turn off the printer.

2. Open the front cover by pressing the button on the left side of the printer and lowering the cover.

3. Remove the toner cartridge assembly from the printer by pulling on the toner cartridge handle.

**NOTE:** Do not press the button on the toner cartridge assembly.
Place the toner cartridge assembly on a flat, clean surface.

**NOTICE:** Do not leave the toner cartridge assembly exposed to direct light for an extended period of time. Extended light exposure can cause print quality problems.

4. Locate the glass printhead lens, which is located within the recessed area in the top of the printer.

5. Gently wipe the printhead lens with a clean, dry, lint-free cloth.

**NOTICE:** Not using a clean, dry, lint-free cloth may result in damage to the printhead lens.

6. Install the toner cartridge assembly into the printer by aligning the blue arrows on the guides of the toner cartridge assembly with the blue arrows on the tracks in the printer and pushing the toner cartridge assembly in as far as it will go.

7. Close the front cover.

8. Turn on the printer.
# Operator Panel Lights

- **Common Light Sequences**
- **Secondary Error Light Sequences**
- **Paper Jam Secondary Light Sequences**
- **Printer Status**

The operator panel lights mean different things, depending on their sequence. Lights that are off, on, and/or blinking indicate printer conditions such as printer status, intervention (for example, load paper), or service. The lights can be either green or orange, depending on what they represent.

<table>
<thead>
<tr>
<th>Off</th>
<th>On</th>
<th>Slow blink</th>
<th>Fast Blink</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light On" /></td>
<td><img src="image" alt="Light Slow Blink" /></td>
<td><img src="image" alt="Light Fast Blink" /></td>
</tr>
</tbody>
</table>

## Common Light Sequences

The following table shows the most common light sequences. Click the links in the right column for more information on what you can do.

<table>
<thead>
<tr>
<th>Continue</th>
<th>Ready/Data</th>
<th>Toner Low/Replace Drum</th>
<th>Load Paper/Remove Output</th>
<th>Paper Jam</th>
<th>Error</th>
<th>Printer Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Light On" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Not Ready</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Slow Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Ready/Power Saver</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Fast Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Busy</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>88 Toner Low</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Output Bin Full — Remove Paper</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Load &lt;input source&gt; &lt;type&gt; &lt;size&gt;</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Load Manual &lt;type&gt; &lt;size&gt;</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Insert Duplex Pages in Tray 1, Then Press Continue</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Hex Trace Ready</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Flushing/Resolution Reduced</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>Waiting</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>84 Imaging Drum Life Warning</strong></td>
</tr>
<tr>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Off" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><img src="image" alt="Light Blink" /></td>
<td><strong>84 Replace Imaging Drum</strong></td>
</tr>
</tbody>
</table>

- Canceling print job
- Resetting printer
- Restoring factory defaults

- Close the font cover
- Insert toner cartridge
Secondary Error Light Sequences

When the Error and Continue lights are both on, a secondary error has occurred. Press the Continue button twice to display secondary code light sequences. The following table shows the secondary error light sequences.

<table>
<thead>
<tr>
<th>Continue</th>
<th>Ready/Data</th>
<th>Toner Low/Replace Drum</th>
<th>Load Paper/Remove Output</th>
<th>Paper Jam</th>
<th>Error</th>
<th>Printer Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30 Invalid Refilled Cartridge</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>31 Missing or Defective Cartridge</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>32 Unsupported Print Cartridge</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>34 Paper Too Short</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>35 Insufficient Memory for Resource Save</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>37 Insufficient Memory to Collate</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>37 Insufficient Defrag Memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>38 Memory Full</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>54 Standard Network Software Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>56 Standard Parallel/USB Port Disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>58 Too Many Flash Options</td>
</tr>
</tbody>
</table>

Paper Jam Secondary Light Sequences

When the Error and Continue lights are both on, a secondary error has occurred. Press the Continue button twice to display secondary error code light sequences that show the exact type of paper jam. The following table shows the paper jam light sequences.

<table>
<thead>
<tr>
<th>Continue</th>
<th>Ready/Data</th>
<th>Toner Low/Replace Drum</th>
<th>Load Paper/Remove Output</th>
<th>Paper Jam</th>
<th>Error</th>
<th>Printer Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>200 Paper Jam — Remove Cartridge</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>201 Paper Jam — Remove</td>
</tr>
</tbody>
</table>

1 For more information, see Paper Jam Secondary Light Sequences.
2 For more information, see Secondary Error Light Sequences.
Printer Status

Ready/Power Saver

- The printer is ready to receive and process data.
- The printer is in Power Saver mode.

**NOTE:** If you want to change the Power Saver setting, it can only be set from the Local Printer Settings Utility.

Busy

- The printer is busy receiving and processing data, or is printing.
- The printer is defragmenting the flash memory to reclaim storage space occupied by deleted resources.
- The printer is formatting the flash memory.
- The printer is storing resources, such as fonts or macros, in flash memory.
- The printer is printing a directory, font list, menu settings pages, or Print Quality Test Pages.

Hex Trace Ready

The printer is in the Ready mode, and Hex Trace is active. You can use Hex Trace to troubleshoot printer problems.

Waiting

* Paper jams at the input sensor can be either after the paper leaves the tray and enters the printer or in the manual feeder.
The printer is waiting until a print timeout occurs, or until it receives additional data.

**Flushing/Resolution Reduced**

- The printer is flushing corrupted print data.
- The printer is processing data or printing pages, but the resolution of a page in the current print job is reduced from 600 dots per inch (dpi) to 300 dpi to prevent a memory full error.

**Not Ready**

- The printer is not ready to receive or process data.
- The printer ports are offline.
Troubleshooting

Basic Problems

Use the following information to find solutions for printing problems you encounter. If you cannot fix the problem, contact Dell at support.dell.com. You may have a printer part that requires cleaning or replacement by a service technician.

The print is getting light, but the Toner Low/Replace Drum light is not on.

1. Remove the toner cartridge.
2. Firmly shake it side-to-side and front-to-back several times to redistribute the toner.
3. Reinsert the toner cartridge, and continue printing.

Repeat this procedure multiple times until the print remains faded. When the print remains faded, replace the toner cartridge.

The Toner Low/Replace Drum light is on (not blinking).

1. Remove the toner cartridge.
2. Firmly shake it side-to-side and front-to-back several times to redistribute the toner.
3. Reinsert the toner cartridge, and continue printing.

Repeat this procedure multiple times until the print remains faded. When the print remains faded, replace the toner cartridge.

The Toner Low/Replace Drum light is blinking.

The imaging drum is approaching full and needs to be replaced. Order a new imaging drum.

The Toner Low/Replace Drum and the Error lights are blinking.

The imaging drum is full and needs to be replaced. The printer will not print any more pages until the imaging drum is replaced.

The Load Paper light is on, even though there is paper loaded in Tray 1 or Tray 2.

Ensure that the tray is pushed in all the way.

The printer is on, and the Error light is on.

Ensure that the printer cover is closed.

The operator panel lights do not come on when the printer is turned on.
• Wait to see if the lights come on. This may take a few seconds.

• Ensure that the power cable is firmly plugged in at the back of the printer and at the electrical outlet.

**Pages are blank.**

• The toner cartridge may be out of toner. Replace the cartridge.

• You may have a software error. Try turning the printer off and back on again.

**The printer is on, but nothing prints.**

• Ensure that the toner cartridge is installed.

• Ensure that the parallel, USB, or network cable is firmly plugged into the connector on the back of the printer.

• Press and release the **Continue** button to print a menu settings page to determine if the problem is with the printer or computer.
  
  - If you can print a menu settings page, the problem is in the computer or the software program.
  
  - If you cannot print a menu settings page, contact Dell at [support.dell.com](http://support.dell.com).

**You cannot close the front cover.**

Ensure that the toner cartridge is positioned correctly.

**The printer has missing or damaged parts.**

Contact Dell at [support.dell.com](http://support.dell.com).

**You have a paper jam.**

When a paper jam occurs, the printer stops and the operator panel's **Paper Jam** and **Continue** lights come on. Press and release the **Continue** button twice quickly to display the specific secondary error paper jam light sequence.

Dell recommends you clear the entire paper path when a paper jam occurs.

1. If you are feeding paper from a tray, remove the tray, and then remove any jams.

2. Open the front cover, and then remove the toner cartridge assembly.
3. Remove any jams in the area behind the toner cartridge assembly.

4. Lift the flap at the front of the printer, and remove any jams beneath the flap.

5. Open the rear exit, and remove any jams.

6. Reinstall the toner cartridge assembly, and then close the front and rear covers.

7. Replace the paper trays, ensure that they are closed, and then press the Continue button to resume printing.

**NOTE:** The printer reprints the pages that caused the paper jam.

---

**Print Quality Problems**

Use the following information to find solutions for printing problems you encounter. If you cannot fix the problem, contact Dell at support.dell.com. You may have a printer part that requires cleaning or replacement by a service technician.
Print is too light.

- The Toner Darkness superscript 1 setting is too light.
- You are using paper that does not meet the printer specifications.
- The toner cartridge is low on toner.
- The toner cartridge is defective.

Try the following:

- Select a different Toner Darkness superscript 1 setting from the printer software before sending the job to print.
- Load paper from a new package.
- Avoid textured paper with rough finishes.
- Ensure that the paper you load in the trays is not damp.
- Replace the toner cartridge.

Print is too dark, or the background is gray.

- The Toner Darkness superscript 1 setting is too dark.
- The toner cartridge is defective.

Try the following:

- Select a different Toner Darkness superscript 1 setting from the printer software before sending the job to print.
- Replace the toner cartridge.

White lines appear on the page.

- The printhead lens is dirty.
- The toner cartridge is defective.
- The fuser is defective.

Try the following:

- Clean the printhead lens.
- Replace the toner cartridge.
- Replace the fuser.

Streaked horizontal lines appear on the page.

- The toner cartridge may be defective, empty, or worn.
- The fuser may be worn or defective.

Try the following:

- Replace the toner cartridge.
Streaked vertical lines appear on the page.

- Toner is smeared before fusing to the paper.
- The toner cartridge is defective.

Try the following:

- If the paper is stiff, try feeding from another tray or the manual feeder.
- Replace the toner cartridge.

The page contains print irregularities.

- Paper has absorbed moisture due to high humidity.
- You are using paper that does not meet the printer specifications.
- The fuser is worn or defective.

Try the following:

- Load paper from a fresh package into the paper tray.
- Avoid textured paper with rough finishes.
- Ensure that the printer software Paper Type setting matches the type of paper you are using.
- Replace the fuser.

The transparency print quality is poor. (Print has inappropriate light or dark spots, toner is smeared, or horizontal or vertical light bands appear.)

- You are using transparencies that do not meet the printer specifications.
- The Paper Type setting in the printer software is set to something other than Transparency.

Try the following:

- Use only transparencies recommended by Dell.
- Ensure that the printer software Paper Type setting is transparency.

Toner specks appear on the page.

- The toner cartridge is defective.
- The fuser is worn or defective.
- Toner is in the paper path.

Try the following:

- Replace the toner cartridge.
- Replace the fuser.
- Call for service.

**Toner rubs off the paper easily when you handle the sheets.**

- The Paper Texture setting is wrong for the type of paper or specialty media you are using.
- The Paper Weight setting is wrong for the type of paper or specialty media you are using.
- The fuser is worn or defective.

Try the following:

- Change the Paper Texture\(^1\) from Smooth or Rough.
- Change the Paper Weight\(^1\) from Plain to CardStock (or other appropriate weight).
- Replace the fuser.\(^2\)

**Print density is uneven.**

The toner cartridge is defective.

Replace the toner cartridge.

**Ghost images appear on the page.**

- The Paper Type setting in the printer software is set incorrectly.
- The toner level is low in the toner cartridge.

Try the following:

- Ensure that the printer software Paper Type setting is correct for the paper or specialty media you are using.
- Replace the toner cartridge.

**Print only appears on one side of the page.**

The toner cartridge is not properly installed.

Remove and reinsert the toner cartridge.

**Margins are incorrect.**

The Paper Size setting in the printer software is set incorrectly.

Ensure that the printer software Paper Size setting is correct for the paper or specialty media you are using.

**Print is skewed (inappropriately slanted).**

- The guides in the selected tray are not in the correct position for the paper size loaded in the tray.
- The manual feeder's guides are not in the correct position for the paper size loaded in the feeder.

Try the following:

- Move the guides in the tray so they rest against the edges of the paper.
- Move the manual feeder's guides so they rest against the edges of the paper.
Printed pages are blank.
The toner cartridge is empty or defective.
Replace the toner cartridge.

Printed pages are solid black.
- The toner cartridge is defective.
- Your printer requires servicing.

Try the following:
- Replace the toner cartridge.
- Call for service.

Paper curls badly once it prints and exits to the bin.
The Paper Texture\(^1\) setting is wrong for the type of paper or specialty media you are using.
Change the Paper Texture\(^1\) from Rough to Normal or Smooth.

1. This setting can be changed using the Local Printer Settings Utility.
2. Call a service technician to replace the fuser.

Error Recovery

Load <input source> <type> <size>
Load the specified paper input tray with the designated paper type and size.

Load Manual <type> <size>
Load the manual feeder with the designated paper type and size.

Output Bin Full — Remove Paper
Remove any paper from the output bin, and then press the Continue button.

Insert Duplex Pages in Tray 1, Then Press Continue

\[\text{NOTE:}\] This message only appears if you are using a printer without an automatic duplex unit.

1. Remove the printed pages from the output bin.
2. Remove Tray 1.
3. Load the tray with the already printed side facing up, and the top of the page toward the front of the tray.
NOTE: Although you can use Tray 1 or Tray 2 to print the first side of the duplex job, only use Tray 1 to print the second side.

4. Replace Tray 1.

5. Press the Continue button.

30 Invalid Refilled Cartridge
The cartridge in your printer has been refilled. Install a new toner cartridge.

31 Missing or Defective Cartridge
- If the toner cartridge is not installed, install it.
- If the toner cartridge is installed, remove it and install a new toner cartridge.

32 Unsupported Print Cartridge
Install the correct toner cartridge for your printer.

34 Paper Too Short
- Make sure the paper you loaded is large enough.
- Check for a paper jam.
- To clear the message and continue printing the job, press the Continue button. The remaining pages of the print job may not print correctly.

35 Insufficient Memory for Resource Save
- To clear the message, press the Continue button.
- To cancel the print job, press the Cancel button.
To prevent this error in the future, install additional memory.

37 Insufficient Memory to Collate
- To clear the message and continue printing, press the Continue button. The remaining pages of the job may not print correctly.
To cancel the print job, press the Cancel button.

To prevent this error in the future:

- Install additional memory.
- Simplify the job. Reduce the complexity of the page by reducing the amount of text or graphics on the page and deleting unnecessary fonts or macros.

### 37 Insufficient Defrag Memory

- To clear the message, press the Continue button.
- To cancel the print job, press the Cancel button.

To prevent this error in the future, install additional memory.

### 38 Memory Full

- To clear the message and continue printing, press the Continue button. The remainder of the print job may not print correctly.
- To cancel the print job, press the Cancel button.

To prevent this error in the future:

- Simplify the job. Reduce the complexity of the page by reducing the amount of text or graphics on the page and deleting unnecessary fonts or macros.
- Install additional memory.

### 54 Standard Network Software Error

- To clear the message and disable all communication between the printer and the network, press the Continue button.
- To ignore the message, press the Cancel button.

### 56 Standard Parallel/USB Port Disabled

To clear the message, press the Continue button. The printer discards any previously sent print jobs. Enable the parallel or USB port by selecting a value other than Disabled for the Parallel Buffer or USB Buffer item in the Local Printer Settings Utility.

### 58 Too Many Flash Options

Remove the memory from your printer. Your printer supports up to 128 MB additional flash memory.

### 81 Engine Code CRC Failure

Press the Continue button to clear the message.
84 Imaging Drum Life Warning

NOTE: You only receive the imaging drum life warning if you have the Toner Alarm set to on.

- To continue printing, press the Continue button.
- Print a Printer Settings Configuration Sheet to determine the imaging drum level.
- Replace the imaging drum, and reset the counter.

84 Replace Imaging Drum

Your printer will not print any more pages until the imaging drum has been replaced.

Replace the imaging drum, and reset the counter.

88 Toner Low

- Remove the toner cartridge, and firmly shake it to redistribute the toner within the cartridge.
- Replace the toner cartridge.

200 Paper Jam — Remove Cartridge

There is a paper jam at the printer input sensor.

1. Open the front cover by pressing the button on the left side of the printer and lowering the cover.

2. Press the button on the toner cartridge assembly, and then pull the toner cartridge up and out using the handle.

3. Remove the jammed paper.

4. Reinstall the toner cartridge by aligning the white rollers on the toner cartridge with the white arrows on the tracks of the imaging drum and pushing the toner cartridge in as far as it will go. The cartridge clicks into place when
5. Close the front cover.

6. Press the Continue button.

**NOTE:** The printer reprints the pages that caused the paper jam.

### 201 Paper Jam — Remove Cartridge

There is a paper jam between the printer input and paper exit sensors.

1. Open the front cover by pressing the button on the left side of the printer and lowering the cover.

2. Press the button on the toner cartridge assembly, and then pull the toner cartridge up and out using the handle.

3. Remove the jammed paper.

4. Reinstall the toner cartridge by aligning the white rollers on the toner cartridge with the white arrows on the tracks of the imaging drum and pushing the toner cartridge in as far as it will go. The cartridge clicks into place when correctly installed.
5. Close the front cover.

6. Press the **Continue** button.

   ☑️ **NOTE:** The printer reprints the pages that caused the paper jam.

### 202 Paper Jam — Open Rear Door

There is a paper jam at the printer exit sensor.

1. Open the rear exit.

2. Remove the jammed paper.

3. Close the rear exit.

4. Press the **Continue** button.

   ☑️ **NOTE:** The printer reprints the pages that caused the paper jam.

### 231 Duplex Paper Jam — Open Rear Door

| ☑️ **NOTE:** This message appears only if the printer has an automatic duplex unit. |

There is a paper jam in the rear of the duplex paper path.

1. Open the rear exit.

2. Remove the jammed paper.
3. Close the rear exit.

4. Press the Continue button.

**NOTE:** The printer reprints the pages that caused the paper jam.

### 232 Duplex Paper Jam — Remove Tray 1

**NOTE:** This message appears only if the printer has an automatic duplex unit.

There is a paper jam in the duplex unit.

1. Remove Tray 1.

2. Press down the lever on the automatic duplex unit.

3. Remove the jammed paper.

4. Replace Tray 1.

5. Press the Continue button.

**NOTE:** The printer reprints the pages that caused the paper jam.

### 233 Duplex Paper Jam — Remove Tray 1

**NOTE:** This message appears only if the printer has an automatic duplex unit.

There is a paper jam in the front of the duplex unit.

1. Remove Tray 1.

2. Press down the lever on the automatic duplex unit.

3. Remove the jammed paper.

4. Replace Tray 1.
5. Press the **Continue** button.

   **NOTE:** The printer reprints the pages that caused the paper jam.

### 234 Paper Jam — Check Duplex

**NOTE:** This message appears only if the printer has an automatic duplex unit.

There is a paper jam in the duplex unit, but the printer cannot identify the location.

1. Remove Tray 1.
2. Press down the lever on the automatic duplex unit.
3. Remove any jammed paper.
4. Replace Tray 1.
5. Open the rear exit.
6. Remove any jammed paper.
7. Close the rear exit.
8. Press the **Continue** button.

   **NOTE:** The printer reprints the pages that caused the paper jam.

### 235 Duplex Paper Jam — Unsupported Size

**NOTE:** This message appears only if the printer has an automatic duplex unit.

There is a paper jam at the output bin because the paper used was too narrow for the duplex unit.

1. Open the rear exit.
2. Remove the jammed paper.

3. Close the rear exit.

4. Press the Continue button.

   **NOTE:** The printer reprints the pages that caused the paper jam.

5. Replace the narrow paper in Tray 1 with a wider paper.

6. Send your print job to the printer again.

### 241 Paper Jam — Check Tray 1

There is a paper jam in Tray 1.

1. Remove Tray 1.

2. Remove the jammed paper.

3. Replace Tray 1.

4. Press the Continue button.

   **NOTE:** The printer reprints the pages that caused the paper jam.

### 242 Paper Jam — Check Tray 2

There is a paper jam in Tray 2.

1. Remove Tray 2.

2. Remove the jammed paper.

3. If you did not see any jammed paper when you removed Tray 2, remove Tray 1 and then remove any jammed paper.

4. Replace both paper trays.

5. Press the Continue button.

   **NOTE:** The printer reprints the pages that caused the paper jam.

### 251 Paper Jam — Check Manual Feeder

There is a paper jam at the manual feeder.

1. Remove the jammed paper from the manual feeder.
2. Insert a blank sheet of paper in the manual feeder.

3. Press the Continue button.

---

**Calling for Service**

Before calling for service, check the following:

- Is the power cable plugged into the printer?
- Is the power cable plugged directly into a properly grounded electrical outlet?
- Is your printer properly connected to your computer or network?
- Are all other devices attached to your printer plugged in and turned on?
- Is the electrical outlet turned off by any switches?
- Did a fuse blow?
- Has a power outage occurred in your area?
- Is a toner cartridge installed in your printer?
- Is the printer cover closed properly?

Try turning your printer off and back on again. If your printer is still not operating properly, call for service. If you are able to print, press and release the Continue button to print a menu settings page, which lists the printer model type and other information the service representative may need to know.

For more information, contact Dell at support.dell.com.
Installing Optional Hardware

- Installing the 550-Sheet Optional Drawer
- Configuring the Paper Trays
- Installing an Optional Memory Card

Installing the 550-Sheet Optional Drawer

An optional drawer attaches under the printer. A drawer consists of two parts: a tray and a support unit. Your printer supports one optional drawer that holds up to 550 sheets of paper.

⚠️ **CAUTION:** If you are installing a drawer after setting up the printer, turn off the printer, and unplug the power cable before continuing.

1. Unpack the drawer, and remove any packing material.
2. Place the drawer in the location you have chosen for your printer.
   
   **NOTE:** If you have optional memory to install, leave clearance on the right side of the printer.

3. Align the holes in the printer with the positioning posts on the drawer, and lower the printer into place.

![Diagram of installing the 550-Sheet Optional Drawer]

Configuring the Paper Trays

**NOTE:** You must first install the software for your printer before configuring the paper trays. For more information, see Setting up for Local Printing or Setting up for Network Printing.

**Dell™ Laser Printer 1720/1720dn — Attached Locally to a Computer**

1. Click **Start® Programs** or **All Programs® Dell Printers® Dell Laser Printer 1720**.

   *For Windows Vista (default Start menu):*

   a. Click **Programs**.
b. Click Dell Printers.

c. Click Dell Laser Printer 1720.

2. Click Dell Local Printer Settings Utility.

3. Select your Dell Laser Printer 1720.

4. Click OK.

5. In the left column, click Paper.

6. In the right column, go to the Tray 1 section. Specify what size and type of media you loaded into Tray 1.

7. In the right column, go to the Tray 2 section. Specify what size and type of media you loaded into Tray 2.

8. Click Actions® Apply Settings.

9. Close the utility.

**NOTE:** If you change the size or type of media loaded in either tray, use the Local Printer Settings Utility to reconfigure the tray.

10. Update your printer options.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® XP (default Start menu)</td>
<td>a. Click Start® Control Panel.</td>
</tr>
<tr>
<td></td>
<td>b. Double-click Printers and Other Hardware.</td>
</tr>
<tr>
<td></td>
<td>c. Double-click Printers and Faxes.</td>
</tr>
<tr>
<td></td>
<td>d. Right-click the Dell Laser Printer 1720 icon.</td>
</tr>
<tr>
<td></td>
<td>e. Click Properties.</td>
</tr>
<tr>
<td></td>
<td>f. Click Install Options.</td>
</tr>
<tr>
<td></td>
<td>g. Click Ask Printer.</td>
</tr>
<tr>
<td></td>
<td>h. Click OK.</td>
</tr>
<tr>
<td></td>
<td>i. Click OK, and then close the Printers folder.</td>
</tr>
<tr>
<td>Windows XP (Classic Start menu)</td>
<td>a. Click Start® Settings® Printers and Faxes.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click the Dell Laser Printer 1720 icon.</td>
</tr>
<tr>
<td></td>
<td>c. Click Properties.</td>
</tr>
<tr>
<td></td>
<td>d. Click Install Options.</td>
</tr>
<tr>
<td></td>
<td>e. Click Ask Printer.</td>
</tr>
<tr>
<td></td>
<td>f. Click OK.</td>
</tr>
<tr>
<td></td>
<td>g. Click OK, and then close the Printers folder.</td>
</tr>
<tr>
<td>Windows Vista (Classic Start menu)</td>
<td>a. Click Start® Settings® Printers.</td>
</tr>
<tr>
<td></td>
<td>c. Click Properties.</td>
</tr>
<tr>
<td></td>
<td>d. Click Install Options.</td>
</tr>
<tr>
<td></td>
<td>e. Click Ask Printer.</td>
</tr>
<tr>
<td></td>
<td>f. Click OK.</td>
</tr>
<tr>
<td></td>
<td>g. Click OK, and then close the Printers folder.</td>
</tr>
<tr>
<td>Windows NT 4.0</td>
<td>a. Click Start® Settings® Printers.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click the Dell Laser Printer 1720 icon.</td>
</tr>
<tr>
<td></td>
<td>c. Click Properties® Features or Update.</td>
</tr>
<tr>
<td></td>
<td>d. Click OK.</td>
</tr>
<tr>
<td></td>
<td>e. Click OK, and then close the Printers folder.</td>
</tr>
<tr>
<td>Windows Vista (default Start menu)</td>
<td>a. Click © Control Panel.</td>
</tr>
<tr>
<td></td>
<td>b. Click Hardware and Sound.</td>
</tr>
<tr>
<td></td>
<td>c. Click Printers.</td>
</tr>
<tr>
<td></td>
<td>d. Right-click the Dell Laser Printer 1720 icon.</td>
</tr>
<tr>
<td></td>
<td>e. Click Properties.</td>
</tr>
<tr>
<td></td>
<td>f. Click Install Options.</td>
</tr>
<tr>
<td></td>
<td>g. Click Ask Printer.</td>
</tr>
</tbody>
</table>
If *Ask Printer* is unavailable, follow these steps:

1. In the *Available Options* list, click **550-sheet tray**.
2. Click **Add**.
3. Click **OK**, and then close the Printers folder.

---

**Dell Laser Printer 1720dn — Attached to a Network**

Setting the paper size and type for the printer is done through the Dell Printer Configuration Web Tool.

*NOTE:* Configuring paper trays through the Dell Printer Configuration Web Tool is only available on the Dell Laser Printer 1720dn.

1. Type your network printer's IP address in your Web browser.
   - **NOTE:** If you do not know your printer's IP address, print a network setup page, which lists the IP address.
2. When the Printer Status page opens, select **Printer Settings** in the left column.
3. From the Printer Settings page, select **Paper Menu**.
4. Select **PAPER SIZE**.
5. Select the paper size you have in each tray.
6. Click **Submit**.
7. Select **Printer Settings** in the left column.
8. From the Printer Settings page, select **Paper Menu**.
9. Select **PAPER TYPE**.
10. Select the paper type you have in each tray.
11. Click **Submit**.

---

### Installing an Optional Memory Card

The system board has one connector for an optional memory card. The printer can support up to 128 MB (for a total of 160 MB for a network printer and 144 MB for a non-network printer.) The printer memory can only be upgraded using 32 MB, 64 MB, or 128 MB memory cards.

**CAUTION:** If you are installing a memory card after setting up the printer, turn off the printer, and unplug the power cable before continuing.

1. Open the front cover by pressing the button on the left side of the printer and lowering the cover.
2. Open the rear exit.

3. Open the side cover by pressing the two detents on the front right side of the machine and swinging the cover back.

4. Remove the metal cover by loosening the screws, sliding the cover to the left, and pulling the cover out of the printer.

5. Push open the latches on both ends of the memory connector.

**NOTICE:** Memory cards are easily damaged by static electricity. Touch a grounded metal surface before you touch a memory card.

**NOTE:** Memory cards designed for other printers may not work with your printer.

6. Unpack the memory card.

   Avoid touching the connection points along the edge of the card.

7. Align the notches on the bottom of the card with the notches on the connector.
8. Push the memory card firmly into the connector until the latches on both ends of the connector snap into place. It may require some force to fully seat the card.

9. Ensure that each latch fits over the notch on each end of the card.

10. Close the side cover.

11. Close the rear exit.

12. Close the front cover.

13. Update your printer options.

   a. For Windows XP (default Start menu):
      1. Click **Start** ® **Control Panel**.
      2. Double-click **Printers and Other Hardware**.
      3. Double-click **Printers and Faxes**.

   For Windows XP (Classic Start menu): Click **Start** ® **Settings** ® **Printers and Faxes**.
   For Windows Vista (Classic Start menu) and all other Windows versions: Click **Start** ® **Settings** ® **Printers**.

   For Windows Vista (default Start menu):
      1. Click ® **Control Panel**.
      2. Click **Hardware and Sound**.
      3. Click **Printers**.

   b. Right-click the **Dell Laser Printer 1720** icon, and then select **Properties**.

   c. Click the **Install Options** tab.

   d. Increase the amount of memory in the **Printer Memory (MB)** box.

   e. Click **OK**.
Specifications

- Overview
- Environmental Specifications
- Noise Emissions Levels
- Emulation, Compatibility, and Connectivity
- MIB Compatibility
- Operating System Support
- Print Media Guidelines
- Media Types and Sizes
- Cables
- Certifications

Overview

<table>
<thead>
<tr>
<th></th>
<th>1720</th>
<th>1720dn</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base memory</td>
<td>16 MB</td>
<td>32 MB</td>
</tr>
<tr>
<td>Maximum memory</td>
<td>144 MB</td>
<td>160 MB</td>
</tr>
<tr>
<td>Connectivity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Parallel</td>
<td>Parallel</td>
</tr>
<tr>
<td></td>
<td>USB</td>
<td>USB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10/100BaseTx Ethernet</td>
</tr>
<tr>
<td>Ships with print cartridge yield at approximately 5% coverage</td>
<td>1,500 pages</td>
<td>3,000 pages</td>
</tr>
<tr>
<td>Duty cycle (average)</td>
<td>500 pages/month</td>
<td>500 pages/month</td>
</tr>
<tr>
<td>Duty cycle (maximum)</td>
<td>25,000 pages/month</td>
<td>25,000 pages/month</td>
</tr>
<tr>
<td>Printer life</td>
<td>120,000 pages</td>
<td>120,000 pages</td>
</tr>
</tbody>
</table>

Environmental Specifications

<table>
<thead>
<tr>
<th>Condition</th>
<th>Temperature</th>
<th>Relative humidity (non-condensing)</th>
<th>Altitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>16 to 32°C (60 to 90°F)</td>
<td>8 to 80%</td>
<td>0 to 2,500 M (8,200 feet)</td>
</tr>
<tr>
<td>Storage</td>
<td>0 to 40°C (32 to 104°F)</td>
<td>8 to 80%</td>
<td></td>
</tr>
<tr>
<td>Shipping</td>
<td>-20 to 40°C (-4 to 104°F)</td>
<td>8 to 95%</td>
<td>0.25 atmospheric pressure (equivalent to 10,300 M; 34,000 feet)</td>
</tr>
</tbody>
</table>

Noise Emissions Levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th>Operating Mode</th>
<th>Bystander Emission Sound Pressure Level Limit</th>
<th>Declared Sound Power Level Limit (LWAd)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>50 dBA</td>
<td>6.5 Bels</td>
</tr>
</tbody>
</table>
Emulation, Compatibility, and Connectivity

<table>
<thead>
<tr>
<th>Emulations</th>
<th>Dell Laser Printer 1720</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• PostScript 3</td>
</tr>
<tr>
<td></td>
<td>• HBP</td>
</tr>
<tr>
<td>Dell Laser Printer 1720dn</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• PostScript 3</td>
</tr>
<tr>
<td></td>
<td>• HBP</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Compatibility</th>
<th>Microsoft Windows Vista</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Microsoft Windows XP</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows NT 4.0</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows NT 4.0 Server</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 2000 Advanced Server</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 2000 Server</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 2000 Professional</td>
</tr>
<tr>
<td></td>
<td>Debian GNU/Linux 3.0, 3.1</td>
</tr>
<tr>
<td></td>
<td>Linpus LINUX Desktop 9.2, 9.3</td>
</tr>
<tr>
<td></td>
<td>Linspire 4.5, 5.0</td>
</tr>
<tr>
<td></td>
<td>Red Flag Linux Desktop 4.0, 5.0</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux WS 3, 4</td>
</tr>
<tr>
<td></td>
<td>SUSE LINUX Enterprise Server 8, 9</td>
</tr>
<tr>
<td></td>
<td>SUSE LINUX Professional 9.2, 9.3, 10.0, 10.1</td>
</tr>
<tr>
<td></td>
<td>Mac OS 9 and Mac OS 10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connectivity</th>
<th>Parallel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USB</td>
</tr>
<tr>
<td></td>
<td>10/100BaseTx Ethernet (1720dn only)</td>
</tr>
</tbody>
</table>

1 PostScript support limited to Macintosh only.

MIB Compatibility

A Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This information helps network administrators manage the network (analyze performance, traffic, errors, and so on). This printer complies with standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and network management software systems, such as Dell OpenManage™, IT Assistant, Hewlett-Packard OpenView, CA Unicenter, Hewlett-Packard Web JetAdmin, Lexmark MarkVision Professional, and so on.

Operating System Support

Your printer supports:

- Microsoft Windows Vista
- Microsoft Windows XP
- Microsoft Windows Server 2003
Print Media Guidelines

Selecting the right paper or other media reduces printing problems. For best print quality, try a sample of the paper or specialty media you are considering before buying large quantities.

⚠️ **CAUTION:** Your product uses a printing process that heats the print media, and heat can cause certain media to release emissions. You must understand the section in your operating instructions that discusses the guidelines for selecting appropriate print media to avoid the possibility of harmful emissions.

- Use 20 lb (70 g/m²) xerographic paper.
- Use transparencies designed for laser printers.
- Use paper labels designed for laser printers.
- Use envelopes made from 24 lb (90 g/m²) bond paper. To reduce paper jams, do not use envelopes that:
  - Have excessive curl.
  - Are stuck together.
  - Contain windows, holes, perforations, cutouts, or embossing.
  - Use metal clasps, string ties, or metal folding bars.
  - Have postage stamps attached.
  - Have any exposed adhesive when the flap is in the sealed position.
- Use card stock with a maximum weight of 163 g/m² and a minimum size of 3x5 in. (76.2x127 mm).
- Use Letter or A4 only if you are using the automatic duplexing unit.
### Media Types and Sizes

<table>
<thead>
<tr>
<th>Source</th>
<th>Media and Size</th>
<th>Weight</th>
<th>Capacity</th>
</tr>
</thead>
</table>
| **Tray 1**      | • **Paper**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                 • **Labels**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                 • **Transparencies**—A4, Letter                                                | 16-24 lb (60-90 g/m\(^2\)) | • 250 sheets (20 lb paper)  
                  • 50 paper labels  
                  • 50 transparencies |
| **550-Sheet Tray** | • **Paper**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                       • **Labels**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                       • **Transparencies**—A4, Letter                                                | 16-24 lb (60-90 g/m\(^2\)) | • 250 sheets (20 lb paper)  
                      • 50 paper labels  
                      • 50 transparencies |
| **Manual Feeder** | • **Paper**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                           • **Labels**—A4, A5, A6\(^1\), JIS B5, Letter, Legal, Executive, Folio, Statement  
                           • **Transparencies**—A4, Letter  
                           • **Envelopes**—Monarch (7 3/4), 9, Com-10, C5, B5, DL  
                           • **Cardstock**\(^2\)  
                           Minimum Paper Size: 3x5 in. (76x127 mm)  
                           Maximum Paper Size: 8.5x14 in. (216x356 mm) | 16-43 lb (60-163 g/m\(^2\)) | 1 sheet (all media types) |

\(^1\) A6 is supported only for grain long.

\(^2\) When printing cardstock using the manual feeder, open the rear exit.

### Cables

Your printer interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Cable certification</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Parallel</td>
<td>IEEE-1284</td>
</tr>
<tr>
<td>10/100BaseT Ethernet</td>
<td>CAT-5E</td>
</tr>
</tbody>
</table>

### Certifications

USB-IF
Loading Paper

- Loading the 250-Sheet and 550-Sheet Paper Trays
- Loading the Manual Feeder
- Using the Rear Exit

Loading the 250-Sheet and 550-Sheet Paper Trays

Follow these instructions to load paper in the 250-sheet and 550-sheet paper trays.

1. Remove the tray.

![Loading the tray](image)

2. If you are loading legal or folio size paper, you must adjust the paper tray to accommodate the larger paper.
   a. Press down on the latch at the back of the tray.
   b. Expand the tray until the extender locks into place.
   ![Adjusting the tray](image)
   c. Move the rear paper guide to the back of the paper tray.
3. Flex a stack of paper back and forth. Straighten the edges on a level surface.

4. Load the paper in the tray with the print side facing down.

   Ensure that the paper is below the max fill line on the side paper guides. Overloading may cause paper jams.

5. Slide the two side guides and the rear guide until they rest against the edges of the paper.

6. Replace the tray.
7. Extend the paper support on the output bin.

---

**Loading the Manual Feeder**

The manual feeder is located at the front of your printer and can only feed one sheet of print media at a time. You can use the manual feeder to make quick runs of paper types or sizes that are not currently loaded in the paper tray.

To load the manual feeder:

1. Place a sheet of the selected print media, print side facing up, at the center of the manual feeder, but only to the point where its leading edge can contact the paper guides. Otherwise, the printer engages the print media too soon and likely skews the print job.

2. Adjust the paper guides to the print media's width.

3. Hold both sides of the print media close to the manual feeder, and push it into the printer until it automatically engages.

There is a brief pause between the time the printer engages the print media and when it feeds into the printer.

**NOTICE:** Do not force the print media into the feeder. Forcing the media causes jams.

- Insert envelopes with the flap side facing down and with the stamp area as shown.

- Hold transparencies by the edges and avoid touching the print side. Oil from your fingers that is deposited on the transparency can affect print quality.
- Load letterhead facing up, with the top of the sheet entering the printer first.
- If you experience problems with paper feed, turn the paper around.

---

**Using the Rear Exit**

The single-sheet rear exit provides a straight-through paper path to help reduce curling and potential jams. This is especially useful for specialty media, such as transparencies, envelopes, labels, card stock, or index cards.

To use the rear exit, open the rear exit door. When the rear exit door is open, all print jobs come out the rear exit. When closed, all print jobs are sent to the output bin on top of the printer.
Appendix

- Dell Technical Support Policy
- Contacting Dell
- Warranty and Return Policy

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the Operating System, application software and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

- World Wide Web
  - www.dell.com/
  - www.dell.com/ap/ (for Asian/Pacific countries only)
  - www.dell.com/ip/ (for Japan only)
  - www.euro.dell.com (for Europe only)
  - www.dell.com/la/ (for Latin American countries)

- Anonymous file transfer protocol (FTP)
  - ftp.dell.com
    Log in as user: anonymous, and use your email address as your password.

- Electronic Support Service
  - mobile_support@us.dell.com
  - support@us.dell.com
  - apsupport@dell.com (for Asian/Pacific countries only)
  - support.jp.dell.com/ip/ip/tech/email/ (for Japan only)
  - support.euro.dell.com (for Europe only)

- Electronic Quote Service
  - apmarketing@dell.com (for Asian/Pacific countries only)
Warranty and Return Policy

Dell Inc. ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, refer to the Owner’s Manual.
Setting up for Local Printing

- Windows®
- Macintosh
- Linux

Windows®

Some Windows operating systems may already include a printer driver that is compatible with the printer.

**NOTE:** Installing custom drivers do not replace the system driver. A separate printer object is created and appears in the Printers folder.

<table>
<thead>
<tr>
<th>Operating System:</th>
<th>Use this type of cable:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista™</td>
<td>USB or Parallel</td>
</tr>
<tr>
<td>Windows XP</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td></td>
</tr>
<tr>
<td>Windows 2000</td>
<td></td>
</tr>
<tr>
<td>Windows NT</td>
<td>Parallel</td>
</tr>
</tbody>
</table>

Installing the Printer Drivers

**NOTE:** Windows Vista, Windows XP Professional, Windows NT, Windows Server 2003, and Windows 2000 require that you have administrative access to install printer drivers on your computer.

1. Insert the Drivers and Utilities CD.

   The Drivers and Utilities CD launches the installation software automatically.

2. When the Drivers and Utilities CD screen appears, click **Personal Installation - Install the printer for use on this computer only**, and then click **Next**.

3. Select your printer from the drop-down menu.

4. Select **Typical Installation (recommended)**, and then click **Install**.

5. Click **Finish**, connect the printer to the computer using a USB or parallel cable, and turn on the printer.

   Microsoft’s Plug and Play finishes installing the printer and prompts you when setup is completed.

Installing Additional Printer Drivers

1. Turn on your computer, and insert the Drivers and Utilities CD.

   When the Drivers and Utilities CD launches, click **Cancel**.

2. **For Windows XP (default Start menu):**
   a. Click **Start® Control Panel**.
b. Double-click **Printers and Other Hardware**.

c. Double-click **Printers and Faxes**.

*For Windows XP (Classic Start menu):* Click **Start® Settings® Printers and Faxes**.

*For Windows Vista (Classic Start menu) and all other Windows versions:* Click **Start® Settings® Printers**.

*For Windows Vista (default Start menu):*

a. Click **Control Panel**.

b. Click **Hardware and Sound**.

c. Click **Printers**.

3. Double-click **Add Printer**.

   The **Add Printer Wizard** opens.

4. Click **Next**.

5. Select **Local printer attached to this computer**, and then click **Next**.

   You are prompted to attach the printer to the computer.

6. Select the port you want your printer to use, and then click **Next**.

7. Select **Have Disk**.

8. Browse to your CD drive, and select the correct directory for your operating system.

   **NOTE:** If you installed the printer drivers from the **Drivers and Utilities** CD before you connected the printer to your computer, the HBP (host based printing) driver for your operating system was installed by default.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Software Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista</td>
<td>D:\Drivers\Print\Win_2kXP\</td>
</tr>
<tr>
<td>Windows XP</td>
<td></td>
</tr>
<tr>
<td>Windows 2003 Server</td>
<td></td>
</tr>
<tr>
<td>Windows 2000</td>
<td></td>
</tr>
<tr>
<td>Windows NT</td>
<td>D:\Drivers\Print\Win_NT.40\</td>
</tr>
</tbody>
</table>

   **NOTE:** After selecting the directory containing your printer drivers, you may be prompted for additional files in order to continue installation. Insert the operating system CD, and then click **OK**.

9. Click **Open**, and then click **OK**.

10. Select the type of driver you want to install (HBP or PS) in the **Manufacturer** list, and the printer model in the **Printers** list, and then click **Next**.

11. Proceed through the rest of the **Add Printer Wizard**, and then click **Finish** to install the printer driver.

### Installing Additional Printer Software

1. Turn on your computer, and insert the **Drivers and Utilities** CD.

   The **Drivers and Utilities** CD should launch the installation software automatically.
2. Select **Additional Software Installation - Install the printer support software**, and then click **Next**.

3. Select the check boxes next to the printer software you want to install, and then click **Install**.

   The software is installed on your computer.

---

**Macintosh**

Macintosh OS 9 or later is required for USB printing. In order to print to a USB printer, create a Desktop Printer icon (Mac OS 9), or add the printer in Print Center or Printer Setup Utility (Mac OS X).

**Mac OS X: Adding the Printer in Print Center or Printer Setup Utility**

1. Install support for the printer on the computer.
   a. Insert the **Drivers and Utilities** CD.
   b. Double-click the installer package for the printer.
   c. Continue past the Welcome screen and the Read me.
   d. Click **Continue** after viewing the license agreement, and then click **Agree** to accept the terms of the agreement.
   e. Select a destination for the installation, and then click **Continue**.
   f. Click **Install** on the **Easy Install** screen.
   g. Enter the administrator password, and then click **OK**.

      The software is installed on the computer.
   h. Quit the installer when it is finished.

2. Open **Print Center** (10.2) or **Printer Setup Utility** (10.3+), located in `/Applications/Utilities`.

3. **If the USB printer appears in the Printer List:** The printer has been set up successfully, and you can quit the application.

   **If the USB printer does not appear in the Printer List:** Ensure that the USB cable is properly connected between the printer and the computer and that the printer is turned on. After the printer appears in the Printer List, the printer has been set up successfully and you can quit the application.

**Mac OS 9: Creating a Desktop Printer With Desktop Printer Utility**

1. Install support for the printer on the computer.
   a. Insert the **Drivers and Utilities** CD.
   b. Double-click the installer package for the printer.
   c. Continue past the Welcome screen and the Read me.
   d. Click **Continue** after viewing the license agreement, and then click **Agree** to accept the terms of the agreement.
   e. Select a destination for the installation, and then click **Continue**.
   f. Click **Install** on the **Easy Install** screen.
The software is installed on the computer.

g. Quit the installer when it is finished.

2. Open **Desktop Printer Utility**, usually located in **Applications:Utilities**.

3. Select **Printer (USB)**, and then click **OK**.

4. In the **USB Printer Selection** section, click **Change**.

   If the printer does not appear in the **USB Printer Selection** list, ensure that the USB cable is properly connected between the printer and the computer, and that the printer is turned on.

5. Select the printer, and then click **OK**.

   The printer appears in the **Printer (USB)** window.

6. In the **PostScript Printer Description (PPD) File** section, click **Auto Setup**.

   Ensure that the printer PPD matches the printer model.

7. Click **Create**.

8. Click **Save**.

9. Enter a name for the printer, and then click **OK**.

   The printer is saved as a Desktop Printer.

---

**Linux**

Local printing is supported on many Linux platforms, such as Red Hat® and SUSE®.

Printer software packages and installation instructions are available on the **Drivers and Utilities** CD. All the printer software supports local printing using a parallel connection.

To launch the installation instructions for Linux:

1. Insert the **Drivers and Utilities** CD. If the **Drivers and Utilities** CD automatically launches, click **Cancel**.

2. Browse to **D:\unix\docs\<your language>\index.html**, where **D:** is the letter of your CD-ROM drive.
The printer resident software contains:

- Software developed and copyrighted by Dell and/or third parties
- Dell modified software licensed under the provisions of the GNU General Public License version 2 and the GNU Lesser General Public License version 2.1
- Software licensed under the BSD license and warranty statements
- Software based in part on the work of the Independent JPEG Group.

The Dell modified GNU licensed software is free software; you can redistribute it and/or modify it under the terms of the licenses referenced above. These licenses do not provide you any rights to the Dell- or third-party-copyrighted software in this printer.

Since the GNU licensed software that the Dell modifications are based upon is supplied explicitly without warranty, use of the Dell modified version is similarly provided without warranty. See the warranty disclaimers in the referenced licenses for additional details.

---

**BSD License and Warranty statements**

Copyright (c) 1991 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---

**GNU License**

GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to most of the Free Software Foundation's software and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is addressed as "you". Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its
terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:
   a. Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
   b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
   c. Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full notice is found.

1 April 1989
Lexmark International, Inc.

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Library General Public License instead of this License.

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, the recipients should know that what they have is not the original version, so that the original author's reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a "work based on the library" and a "work that uses the library". The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The
act of running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

   a. The modified work must itself be a software library.
   b. You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.
   c. You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.
   d. If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), rather than a "work that uses the library". The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a ”work that uses the Library” with the Library to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. Also, you must do one of these things:

a. Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable ”work that uses the Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b. Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c. Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d. If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same place.

e. Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the ”work that uses the Library” must include any data and utility programs needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under the terms of the Sections above.

b. Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that everyone can redistribute and change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full notice is found.

1 April 1990

Lexmark International, Inc.

That's all there is to it!
Setting up for Network Printing

- **Print and Check the Network Setup Page**

- **Windows®**

- **Install the Shared Printer on Client Computers**

- **Macintosh**

- **Linux**

---

**Print and Check the Network Setup Page**

1. When the **Ready/Data** light is solid, press the **Continue** button to print a menu settings page and a network setup page.

2. Under the **Standard Network Card** heading on the network setup page, ensure that the **Status** is **Connected**.

   If **Status** is **Not Connected**:
   - Ensure that the Ethernet cable is firmly plugged into the back of the printer.
   - Plug the Ethernet cable into another wall outlet.

3. Under the **TCP/IP** heading on the network setup page, ensure that the IP address, netmask, and gateway are what you expected.

4. Ping the printer, and verify that it responds. To ping the printer, type `ping xxx.xxx.xxx.xxx` (where `xxx.xxx.xxx.xxx` is the new printer IP address).

5. If the printer is active on the network, you will receive a reply.

---

**Windows®**

In Windows environments, network printers can be configured for direct printing or shared printing. Both network printing methods require the installation of the printer software and the creation of a network printer port.

**Supported Printer Drivers**

Custom drivers are available on the *Drivers and Utilities* CD.

**Supported Network Printer Ports**


For basic printer functionality, install printer software, and use a system network printer port, such as a Line Printer Remote (LPR) or a standard TCP/IP port. The printer software and port let you maintain a consistent user interface for use with all the printers on the network. Using a custom network port provides enhanced functionality, such as printer status alerts.
Direct Attachment With a Network Cable (Using a Print Server)

A print server is any designated computer that centrally manages all client print jobs. If you are sharing your printer in a small workgroup environment and want to control all print jobs on this network, connect the printer to a print server.

1. Insert the *Drivers and Utilities* CD.
   
The *Drivers and Utilities* CD launches the installation software automatically.

2. When the *Drivers and Utilities* CD screen appears, click *Network Installation - Install the printer for use on a network*, and then click *Next*.

3. Select *I am setting up a print server to share printers with others on the network*, and then click *Next*.

4. Select the network printer(s) you want to install.

   If you do not see your printer listed, click *Refresh List* to refresh the list, or click *Manual Add* to add a printer to the network.

5. Click *Next*.

6. For each printer driver listed:

   - **NOTE:** Two printer drivers are listed for each printer you selected, a PostScript and a Host Based Printing (HBP) driver.

     a. Select the printer driver from the list.

     b. If you want to change the printer name, enter a new name in the *Printer Name* field.

     c. If you want other users to access this printer, select *Share this printer with other computers*, and then enter a share name that users can easily identify.

     d. If you want this printer to be the default printer, select *Set this printer to default*.

     e. If you do not want to install the particular driver for the printer, select *Do not install this printer*.

7. Click *Next*.

8. Select the check box next to the software and documentation you want to install, and then click *Install*.

   The drivers, additional software, and documentation are installed on your computer. When the installation is completed, a *Congratulations!* screen appears.

9. **If you do not want to print a test page:** Click *Finish*.

   **If you want to print a test page:**

   a. Select the check box next to the printer(s) on which you want to print a test page.

   b. Click *Print Test Page*.

   c. Verify the test page printed on the printer(s).

   d. Click *Finish*.

---

Direct Attachment With a Network Cable (No Print Server)

1. Insert the *Drivers and Utilities* CD.

   The *Drivers and Utilities* CD launches the installation software automatically.
2. When the *Drivers and Utilities* CD screen appears, click **Network Installation - Install the printer for use on a network**, and then click **Next**.

3. Select **I want to use a network printer on this computer**, and then click **Next**.

4. Select the network printer(s) you want to install.

   If you do not see your printer listed, click **Refresh List** to refresh the list, or click **Manual Add** to add a printer to the network.

5. Click **Next**.

6. For each printer driver listed:

   - **NOTE:** Two printer drivers are listed for each printer you selected, a PostScript and an HBP driver.
     a. Select the printer driver from the list.
     b. If you want to change the printer name, enter a new name in the **Printer Name** field.
     c. If you want other users to access this printer, select **Share this printer with other computers**, and then enter a share name that users can easily identify.
     d. If you want this printer to be the default printer, select **Set this printer to default**.
     e. If you do not want to install the particular driver for the printer, select **Do not install this printer**.

7. Click **Next**.

8. Select the check box next to the software and documentation you want to install, and then click **Install**.

   The drivers, additional software, and documentation are installed on your computer. When the installation is completed, a **Congratulations!** screen appears.

9. **If you do not want to print a test page:** Click **Finish**.

   **If you want to print a test page:**
   a. Select the check box next to the printer(s) on which you want to print a test page.
   b. Click **Print Test Page**.
   c. Verify the test page printed on the printer(s).
   d. Click **Finish**.

**Remotely Installing Network Printer Drivers**

1. Insert the *Drivers and Utilities* CD.

   The *Drivers and Utilities* CD launches the installation software automatically.

2. When the *Drivers and Utilities* CD screen appears, click **Network Installation - Install the printer for use on a network**, and then click **Next**.

3. Select **I want to install printers on remote computers**, and then click **Next**.

4. Enter your administrative user name and password.

5. Select a remote computer(s) from the list, and then click **Next**.

6. Select the network printer(s) you want to install.
If you do not see your printer listed, click **Refresh List** to refresh the list, or click **Manual Add** to add a printer to the network.

7. Click **Next**.

8. For each printer driver listed:

   - **NOTE:** Two printer drivers are listed for each printer you selected, a PostScript and an HBP driver.
     a. Select the printer driver from the list.
     b. If you want to change the printer name, enter a new name in the **Printer Name** field.
     c. If you want other users to access this printer, select **Share this printer with other computers**, and then enter a share name that users can easily identify.
     d. If you want this printer to be the default printer, select **Set this printer to default**.
     e. If you do not want to install the particular driver for the printer, select **Do not install this printer**.

9. Click **Next**.

10. Select the check box next to the software and documentation you want to install, and then click **Install**.

    The drivers, additional software, and documentation are installed on your computer. When the installation is completed, a **Congratulations!** screen appears.

11. **If you do not want to print a test page:** Click **Finish**.

    **If you want to print a test page:**
    a. Select the check box next to the printer(s) on which you want to print a test page.
    b. Click **Print Test Page**.
    c. Verify the test page printed on the printer(s).
    d. Click **Finish**.

### Shared Printing

You can use Microsoft's Point and Print or Peer-to-Peer methods to share a printer on the network with a USB or parallel cable connection. In order to use one of these methods, you must first share the printer and then install the shared printer on client computers.

However, if you use one of these Microsoft methods, you will not have all the Dell features, such as the Status Monitor, that are installed using the **Drivers and Utilities** CD.

- **NOTE:** Windows Vista, Windows XP Professional, and Windows NT require that you have administrative access to share a printer.

### Share the Printer

1. **For Windows XP (default Start menu):**
   a. Click **Start® Control Panel**.
   b. Double-click **Printers and Other Hardware**.
   c. Double-click **Printers and Faxes**.

   **For Windows XP (Classic Start menu):** Click **Start® Settings® Printers and Faxes**.

   **For Windows Vista (Classic Start menu) and all other Windows versions:** Click **Start® Settings® Printers**.
For Windows Vista (default Start menu):

a. Click Control Panel.

b. Click Hardware and Sound.

c. Click Printers.

2. Right-click your printer.

3. Click Sharing.

4. If you are using Windows Vista, you may be prompted to change the sharing options before you can continue. Press the Change Sharing Options button, and then press Continue on the next dialog box.

5. Select Share this printer, and then type a name for the printer.

6. Click Additional Drivers, and then select the operating systems of all network clients printing to this printer.

7. Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

a. Insert the Drivers and Utilities CD, ensure that the drive letter is correct for your CD-ROM drive, and then click OK.

b. If you are using Windows Vista: Browse to a client computer running the operating system, and then click OK.

   For all other Windows versions: Insert the operating system CD, ensure that the drive letter is correct for your CD-ROM drive, and then click OK.

8. Click Close.

To check that the printer was successfully shared:

- Ensure that the printer object in the Printers folder shows it is shared. For example, in Windows 2000, a hand is shown underneath the printer icon.

- Browse My Network Places or Network Neighborhood. Find the host name of the server, and look for the shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the Point and Print method or the Peer-to-Peer method.

Install the Shared Printer on Client Computers

Point and Print

This method is the best use of system resources. The printer server handles driver modifications and print job processing. This lets network clients return to their programs much faster.

If you use the Point and Print method, a subset of software information is copied from the print server to the client computer. This is just enough information to send a print job to the printer.

1. On the Windows desktop of the client computer, double-click My Network Places or Network Neighborhood.

2. Double-click the host name of the print server computer.

3. Right-click the shared printer name, and then click Install or Connect.
Wait for the software information to copy from the print server computer to the client computer, and for a new printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors.


5. Print a test page to verify printer installation.
   a. For Windows XP (default Start menu):
      1. Click Start® Control Panel.
      2. Double-click Printers and Other Hardware.
      3. Double-click Printers and Faxes.
      
   For Windows XP (Classic Start menu): Click Start® Settings® Printers and Faxes.
   For Windows Vista (Classic Start menu) and all other Windows versions: Click Start® Settings® Printers.
   
   For Windows Vista (default Start menu):
      1. Click ® Control Panel.
      2. Click Hardware and Sound.
      3. Click Printers.
      
   b. Right-click the printer you just created.
      
   c. Click Properties.
      
   d. Click Print Test Page.
      
   When a test page prints successfully, printer installation is completed.

Peer-to-Peer

If you use the Peer-to-Peer method, the printer software is fully installed on each client computer. Network clients retain control of software modifications. The client computer handles the print job processing.

1. For Windows XP (default Start menu):
   a. Click Start® Control Panel.
   b. Double-click Printers and Other Hardware.
   c. Double-click Printers and Faxes.
   
   For Windows XP (Classic Start menu): Click Start® Settings® Printers and Faxes.
   For Windows Vista (Classic Start menu) and all other Windows versions: Click Start® Settings® Printers.
   
   For Windows Vista (default Start menu):
      a. Click ® Control Panel.
      b. Click Hardware and Sound.
      c. Click Printers.
   
   2. Click Add Printer to launch the Add Printer Wizard.
   
   3. Click Network Print Server.
4. Select the network printer from the Shared printers list. If the printer is not listed, type the path of the printer in the text box. For example: \\
\<print server host name>\<shared printer name>.

The print server host name is the name of the print server computer that identifies it to the network. The shared printer name is the name assigned during the print server installation process.

5. Click OK.

If this is a new printer, you may be prompted to install printer software. If no system software is available, then you need to provide a path to available software.

6. Select whether you want this printer to be the default printer for the client, and then click Finish.

7. Print a test page to verify printer installation.
   a. For Windows XP (default Start menu):
      1. Click Start® Control Panel.
      2. Double-click Printers and Other Hardware.
      3. Double-click Printers and Faxes.
   For Windows XP (Classic Start menu): Click Start® Settings® Printers and Faxes.
   For Windows Vista (Classic Start menu) and all other Windows versions: Click Start® Settings® Printers.
   For Windows Vista (default Start menu):
      1. Click Control Panel.
      2. Click Hardware and Sound.
      3. Click Printers.
   b. Right-click the printer you just created.
   c. Click Properties.
   d. Click Print Test Page.

When a test page prints successfully, printer installation is completed.

### Macintosh

Mac OS 9 or later is required for network printing. In order to print to a network printer, create a Desktop Printer icon (Mac OS 9) or add the printer in Print Center or Printer Setup Utility (Mac OS 10).

#### Mac OS X: Adding the Printer in Print Center or Printer Setup Utility

1. Install support for the printer on the computer.
   a. Insert the Drivers and Utilities CD.
   b. Double-click the installer package for the printer.
   c. Continue past the Welcome screen and the Read me.
   d. Click Continue after viewing the license agreement, and then click Agree to accept the terms of the agreement.
e. Select a destination for the installation, and then click **Continue**.

f. Click **Install** on the **Easy Install** screen.

g. Enter the administrator password, and then click **OK**.

The software is installed on the computer.

h. Quit the installer when it is finished.

2. Open **Print Center** (10.2) or **Printer Setup Utility** (10.3+) located in **/Applications/Utilities**.

3. From the **Printers** menu, select **Add Printer**.

4. **If you want to print using IP Printing:**

   a. Choose **IP Printing** from the pop-up menu (10.2), or click the IP Printer toolbar icon (10.3+).

   b. Enter the IP address of the printer.

   c. Choose the printer manufacturer from the **Printer Model** pop-up menu.

   d. Select the printer from the list, and then click **Add**.

**If you want to print using AppleTalk:**

   a. Choose **AppleTalk** from the pop-up menu (10.2), or click **More Printers...** and then choose **AppleTalk** from the pop-up menu (10.3+).

   b. Choose the AppleTalk Zone from the list.

   ![NOTE:](image) Look under the AppleTalk heading on the printer network setup page to know which zone and printer to select.

   c. Choose the printer from the list, and then click **Add**.

5. Verify the printer installation.

   a. Open **TextEdit** in **/Applications**.

   b. From the **File** menu, choose **Print**.

   c. Choose **Summary** from the **Copies & Pages** pop-up menu.

   d. **If the correct PPD for the printer model is displayed under the Error Reporting group:** Setup is completed.

   **If Generic PostScript Printer is displayed under the Error Reporting group:** Delete the printer from the **Printer List** in **Print Center** or **Printer Setup Utility**, and follow the instructions again to set up the printer.

**Mac OS 9: Creating a Desktop Printer With Desktop Printer Utility**

1. Install support for the printer on the computer.

   a. Insert the **Drivers and Utilities** CD.

   b. Double-click the installer package for the printer.

   c. Continue past the Welcome screen and the Read me.

   d. Click **Continue** after viewing the license agreement, and then click **Agree** to accept the terms of the agreement.
e. Select a destination for the installation, and then click **Continue**.

f. Click **Install** on the **Easy Install** screen.

The software is installed on the computer.

g. Quit the installer when it is finished.

2. Open **Desktop Printer Utility**, usually located in **Applications:Utilities**.

3. **If you want to print using IP Printing:**
   
a. Choose **Printer (LPR)**, and then click **OK**.

b. In the **LPR Printer Selection** section, click **Change**.

c. Enter the **Printer Address**, leave the **Queue** unspecified, and then click **OK**.

d. In the PostScript Printer Description (PPD) File section, click **Change**.

e. Choose the printer model, and then click **Select**.

f. Click **Create**.

g. Enter a name for the printer, and then click **OK**.

The printer is saved as a Desktop Printer.

**If you want to print using AppleTalk:**

a. Choose **Printer (AppleTalk)**, and then click **OK**.

b. In the **AppleTalk Printer Selection** section, click **Change**.

c. Choose the AppleTalk Zone from the list.

   **NOTE:** Look under the AppleTalk heading on the printer network setup page to know which zone and printer to select.

d. Choose the printer from the list, and then click **OK**.

e. In the PostScript Printer Description (PPD) File section, click **Auto Setup**.

f. Click **Create**.

   g. Click **Save**.

   The printer is saved as a Desktop Printer.

4. Verify the printer installation.

   a. Open **TextEdit** in **/Applications**.

   b. From the **File** menu, choose **Print**.

   c. Choose **Summary** from the **Copies & Pages** pop-up menu.

   d. **If the correct PPD for the printer displayed in the PostScript Printer Description (PPD) file section is correct:** Setup is completed.

      **If Generic PostScript Printer is displayed:** Delete the Desktop Printer, and follow the instructions again to set up the printer.
Linux

Printer software packages and installation instructions are available on the *Drivers and Utilities* CD.

To launch the installation instructions for Linux:

1. Insert the *Drivers and Utilities* CD. If the *Drivers and Utilities* CD automatically launches, click **Cancel**.

2. Browse to **D:\unix\docs\<your language>\index.html**, where **D:** is the letter of your CD-ROM drive.